
Animate Blood Cells in Blender
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SHORT COURSE



Edit Shortcuts

Shift + S

X or delete button

TAB

E

Ctrl + TAB

K

F

snap

delete

toggle edit/object mode

extrude

choose component

knife

add face
Select Shortcuts

A

B

Shift + RMB

Alt + RMB

Ctrl + RMB

Ctrl + "+"

Ctrl + "-"

deselect

box marquee tool

add to selection

select loop

select faces between

grow selection

shrink selection

Navigate Shortcuts

Shift + hold MM wheel

Hold MM wheel

Scroll MM wheel

pan

tumble

zoom

Window Shortcuts (in 3D view) 

N

T

Properties Panel

Tool Shelf

Viewport Shortcuts (in 3D view) 

Z

Shift + Z

wireframe viewport

rendered viewport

Manipulate Shortcuts

R

S

G

X

Y

Z

rotate

scale

move

constrain to X

constrain to Y

constrain to Z

RIGHT   
L E F T  

After selecting R,S or GIn edit mode

completes 
operation

selects

Notes:



Shortcuts Used: Why:
Primitives are created at the 
3D cursor. Other operations 
also depend upon the 
3D cursor’s location. You 
may left click anywhere to 
move the 3D cursor or give 
explicit coordinates in the 
properties panel "N" (not 
to be confused with the 
properties editor)

Shift + S.............................. snap

N....................properties panel 

1.	 After getting familiar with the UI, left click near (-1.5,0,0)

2.	 If your 3D cursor is not quite at (-1.5,0,0) use Shift + S, "Cursor to Grid"

3.	 If left clicking and snapping are unrealiable, press "N" to toggle the 

properties window within 3D view. Find the 3D cursor options and 

manually input coordinates. 
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Steps. The orange text is an alternative step. Keyboard Shortcuts

Blender Screenshot

explanation to 
contextualize the 
steps taken



Shortcuts Used: Why:1.	 Create a cylinder with the above settings
There are many ways to 
model a red blood cell. The 
objective is to keep the 
number of polygons low for 
now.
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Shortcuts Used: Why:1.	 Shift RMB select all of the top and bottom faces.

Tab....toggle edit/object  mode

Ctrl+Tab... change component
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Shortcuts Used: Why:1.	 Hit "E" to extrude and then hit "S" to scale.

2.	 Either left click to complete the scale and type in the above values or 

type in .5,.5,1 while still scaling. 

Right now we are adding 
geometry to prepare for the 
bevel operation

E...................................... extrude

S............................................ scale
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Shortcuts Used: Why:1.	 Alt + RMB select the top edge loop and then shift + Alt + RMB the 

bottom edge loop. These edges will be beveled Alt+RMB................... select loop using Alt to select the entire 

loop saves time
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Shortcuts Used: Why:1.	 Hit Ctrl + "B" to bevel. Use the above settings.

Ctrl + B............................... bevel
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Shortcuts Used: Why:1.	 Select the triangles on top and bottom then hit "E" to extrude and "S" to 

scale them inward. Use settings above. E...................................... extrude

S............................................ scale
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Shortcuts Used: Why:1.	 Repeat the last step 2 more times to get the red blood cell shape.

E...................................... extrude

S............................................ scale
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Shortcuts Used: Why:1.	 Notice that the faces still look faceted. Hit "smooth" under 

Tools>Shading>Smooth. This will change the face 
normals to give a smooth 
look without adding 
polygons.
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Shortcuts Used: Why:1.	 Create>Mesh>Ico Sphere. 

2.	 Note: Make sure that the 3D cursor is at the center (0,0,0). If not, use Shift 

+ "S" to open the snapping menu and select "Cursor to Center" before 

adding Ico Sphere

An Ico Sphere is used to 
make a white blood cell. 
Icosphere is made up of 
evenly distributed triangles 
whereas a UV sphere will 
have triangles meeting at 
the poles which will effect 
the final look.
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Shortcuts Used: Why:1.	 Modifers>Add Modifier>Subdivision Surface

Subdiving the mesh gives 
the cell more resolution 
which will be needed for 
the displacement texture
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Shortcuts Used: Why:
Living things emit light

1.	 Material>New Material 

2.	 Set the "Emit" value to around .2. Emission will make the cell more visible
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Shortcuts Used: Why:
The clouds texture will 
influence the displacement 
of the ico sphere geometry 
giving it a rough, bumpy 
surface

"Generated" automatically 
generates texture 
coordinates according 
to undeformed vertex 
positions

1.	 Texture>Clouds 

Settings: 

Color>Contrast = 2 

Mapping>Coordinates = generated 

play with other settings

2.	 Switch shading mode to "Rendered"
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Shortcuts Used: Why:
Multiple textures can 
influency different aspects 
of the shader. In this 
example we are using the 
same Clouds texture for 
multiple inputs

1.	 Click checkbox for "Displace" 

optional: select checkbox for emit and translucency
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Shortcuts Used: Why:
checking "negative" under 
Blend will invert the texture.

1.	 Cloud Settings: 

Colors = uncheck "clamp" 

Clouds>Noise = "hard" 

Influence>Blend = check "negative"
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Shortcuts Used: Why:
object coordinates uses the 
object as a source for the 
coordinates

1.	 Repeat last 3 steps to create red blood cell shader 

Texture Settings: 

Mapping>Coordinates = "object"
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Shortcuts Used: Why:
Applying scale and rotation 
will give the circle the same 
orientation as world space.

Shift + A............................... add 

1.	 Create NURBS circle with radius 6 and rotation of y=90. 

Note: be sure to select "Curve Circle" and not "Mesh Circle" 

2.	 IMPORTANT: click object> apply> scale and rotation.
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Shortcuts Used: Why:
This path will be the length 
of the blood channel

1.	 Create>Curve>Path
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Shortcuts Used: Why:
Primitives are created at the 
3D cursor. Other operations 
also depend upon the 
3D cursor’s location. You 
may left click anywhere to 
move the 3D cursor or give 
explicit coordinates in the 
properties panel "N" (not 
to be confused with the 
properties editor)

Tab............................ edit mode

N....................properties panel 

1.	 Hit Tab to go into edit mode for path

2.	 Hit "N" to toggle on the properties tab.

3.	 Under Control point set the control points X position from 1-5: 

0,16,32,48,64
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Shortcuts Used: Why:1.	 Hit TAB to toggle back into object mode of Path

2.	 Select BezierCircle as bevel path as shown above
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Shortcuts Used: Why:
Convert is a destructive 
process. After converting, 
no more changes can be 
made to the tube's path

Alt + C............................convert 

1.	 Hit spacebar and type convert or use Alt + C to Convert "Mesh from Curve"

2.	 A mesh is needed for collision to work
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Shortcuts Used: Why:
This polygon circle will be 
the emitter. Particles will 
emit from the circle. If the 
circle is moved, the particles 
will follow.

Shift + A............................... add 

1.	 Create Mesh>Circle with 6 radius and rotation of y=90 with a triangular 

fan fill type

2.	 click object>apply>rotation & scale
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Shortcuts Used: Why:
Paricles must be emitted 
from a polygon mesh

1.	 In properties editor click "New" under particle system tab

Page  25



Shortcuts Used: Why:
Remember: new objects are 
created at the 3D cursor's 
location.

1.	 Set emission rate to 200, lifespan to 180

2.	 Set gravity to 0, mass to .5, and 8 for X under force field settings 

3.	 Press play to test. Hit "z" to toggle into wireframe viewport shading

Z....................... wireframe view
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Shortcuts Used: Why:
Primitives are created at the 
3D cursor. Other operations 
also depend upon the 
3D cursor’s location. You 
may left click anywhere to 
move the 3D cursor or give 
explicit coordinates in the 
properties panel "N" (not 
to be confused with the 
properties editor)

Ctrl + G.............................group

1.	 Shift RMB select both cells and group them (Ctrl+G)
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Shortcuts Used: Why:1.	 Select the emitter circle again and under particles options, set Render to 

"Group". Click in the field box of "Dupli Group" and select the grouped 

cells
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Shortcuts Used: Why:
Primitives are created at the 
3D cursor. Other operations 
also depend upon the 
3D cursor’s location. You 
may left click anywhere to 
move the 3D cursor or give 
explicit coordinates in the 
properties panel "N" (not 
to be confused with the 
properties editor)

Shift + S.............................. snap

N....................properties panel 

1.	 Change the count to have a realistic distribution of red and white cells. 

You must check the "Use Count" box to set the ratio of red and white.
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Shortcuts Used: Why:
Remember: new objects are 
created at the 3D cursor's 
location.

1.	 Make the above changes to "Rotation" under Particle system. Notice the 

change. Select the "Dynamic" checkbox and up the angular velocity to 

give the cells dynamic rotation.
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Shortcuts Used: Why:
Turbulence will give 
the cells a more natural 
movement. Increasing the 
Brownian level has a similair 
effect.

1.	 Hit Add>Force Field>Turbulence. Set the strength to 32.
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Shortcuts Used: Why:
If the tube had not been 
converted to a mesh, the 
collision option would not 
be available.

1.	 Select the gray tube and under physics tab select collision. 
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Shortcuts Used: Why:
It is best to use a low 
polygon model for collision 
and exclude it from 
rendering. Then create a 
high polygon detailed tube 
to be rendered.

1.	 Notice collision
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Shortcuts Used: Why:
This plane will not be 
rendered but serves as 
a stopping point for the 
particles. Once a particle 
hits the plane it will die.

1.	 Create a plane with the above settings. This will be the kill plane
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Shortcuts Used: Why:
Setting the display to wire is 
not required but will make 
your viewport less cluttered

1.	 Select checkbox for "Wire" under display and deselect the camera so the 

plane does not render
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Shortcuts Used: Why:
The plane is very simple: 
only one four sided face. 
The kill plane does not need 
to have a high polygon 
count.

1.	 Under physics tab of plane, enable collision and select checkbox for "kill 

particles" 
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Shortcuts Used: Why:
We are preparing the scene 
for rendering. Before, 
we used the interactive 
viewport render. The final 
rendered images will be 
rendered from this camera.

1.	 Move camera to above settings and change rotation
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Shortcuts Used: Why:1.	 Move and make changes to the lamp 
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Shortcuts Used: Why:
A duplicate will be used 
for render. This duplicate 
will have a higher polygon 
count so we will avoid using 
it for collision which saves 
simulation time.

Shift + D.................... duplicate

1.	 Duplicate the gray tube, the duplicate will be rendered and the original 

will serve only as a collision object
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Shortcuts Used: Why:
Leaving the scale X at 1 will 
insure that the tube staus 
the same length

Tab.............toggle edit/object

A................deselct or select all 

E...................................... extrude 

S............................................ scale

1.	 Extrude the faces and set scale as shown above

2.	 Hit Tab to go back into object mode and under the physics tab turn off 

collision on the new tube.
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Shortcuts Used: Why:1.	 Create an interesting material with a voronoi texture as the displacement 

and/or color
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Pitfalls
Problem Why

The icosphere is without UVs 
 
Solution: you must change the 
coordinates of the texture to 
"generated"

There is not enough geometry to 
displace

Solution: Increase subdivision 
modifier 
 
Note: "view" effects viewport render 
"render" effects the final render 

The nurbs path has control points in 
the wrong order

Solution: move control points in a 
straight line in sequential order

unwanted geometry is set to render

Solution: toggle the camera icon in 
the outliner to exclude the object 
from render or viewport

Displacement not 
appearing correctly

Displacement not 
detailed enough

Odd clipping on collision 
tube

kill plane or collision 
tube shows in render


